
Getting to Know
Adobe Acrobat 

What Is Adobe Acrobat?
If, after perusing your local bookstore, you decided to lay down your
money at the counter, carry away this ten-pound volume, and take it
to bed with you tonight, you probably already know something about
Adobe Acrobat. Why else would you buy this book? If you’re at the
bookstore shelf and you haven’t bought it yet, then you’re probably
wondering how in the world anyone could write so many pages for
such a simple application. After all, isn’t Acrobat that little thingy you
download from the Adobe Web site?

Assuming you know little about Adobe Acrobat, I start with a brief
description of what Acrobat is and what it is not. As I explain to peo-
ple who ask about the product, I usually define it as the most misun-
derstood application available today. Most of us are familiar with the
Adobe Reader software, which is a product from Adobe Systems
Incorporated that you can download for free from the Adobe Web site
(www.adobe.com/acrobat). You can also acquire the Adobe Reader
from all the installation CD-ROMs for other Adobe software. You can
even acquire Adobe Reader from other users, as long as the Adobe
licensing requirements are distributed with the installer program.
The Adobe Reader, however, is not Adobe Acrobat. Adobe Reader is a
component of a much larger product that has evolved through sev-
eral iterations over more than a decade.

You’re probably a little more sophisticated and realize there is a
major difference between the applications noted previously and you
may wonder why I even spend any time discussing the difference
between Acrobat and Adobe Reader. Interestingly enough, I attended
a PDF conference about six months before this book was written. The
conference coincided with another technology conference and one of
the speakers at the PDF conference took a video camera and micro-
phone to the other conference and interviewed random attendees,
asking questions like, “What is Adobe Acrobat?” and “What is PDF?”
Surprisingly, most of the computer-savvy interviewees could not pro-
vide a correct response. Inasmuch as Acrobat has come a long way,
many people still confuse what you purchase from Adobe Systems
and what you can download free.
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4 Part I ✦ Welcome to Adobe Acrobat Professional

To add a little more confusion, this iteration of Acrobat includes three different kinds of
viewer applications. The Adobe Reader software is still a free download from Adobe’s Web
site. The other two Acrobat viewers are software products you need to purchase from Adobe
Systems or from software vendors. They include Adobe Acrobat Standard and Adobe Acrobat
Professional. As I talk about Adobe Acrobat in this chapter, I’m referring to both Acrobat
Standard and Acrobat Professional.

There are distinctions between the Acrobat Standard product and the Acrobat Professional
product in terms of tools and commands. Much of what can be accomplished in editing PDF
documents can be handled by either viewer; however, Acrobat Professional does provide
more editing features than Acrobat Standard. Throughout this book I delineate the differ-
ences and point out when an Acrobat Professional feature cannot be accomplished in
Acrobat Standard.

Adobe Acrobat (either Standard or Professional) is the upgrade from Adobe Acrobat 5 and
both viewers are the subject of the remaining chapters of this book. Acrobat is the authoring
application that provides you tools and commands for a host of features outlined in the fol-
lowing chapters. If you haven’t yet purchased a copy of Acrobat, either the Standard version
or the Professional version, you might want to look over Chapter 2 and observe some of the
comparisons between the viewers. If the fewer tools and features suit your purpose, you
might find the Standard version satisfactory. Although there are some features that differ
between the viewers, they both provide many features for editing, enhancing, printing, and
working with PDF documents.

Acrobat is an authoring application, but it has one little distinction compared to almost any
other authoring program. Rather than starting from scratch and creating a new document in
Acrobat, your workflow usually involves converting a document, created in just about any
program, to a Portable Document Format (PDF) file. Once the document is converted to PDF
you use Acrobat to edit and refine the document, add bells and whistles, interactivity, or pre-
pare it for professional printing. In addition to the Acrobat program, Acrobat Professional
ships with companion programs such as Adobe Acrobat Distiller and Adobe Acrobat Catalog,
and Acrobat Standard ships only with Acrobat Distiller. These companion products are used
to convert PostScript files to PDF and create search indexes.

For information related to Acrobat Distiller, see Chapter 7. For more information on Acrobat
Catalog, see Chapter 4.

Acrobat solutions are greatly extended with other supporting programs from Adobe Systems
and many different third-party vendors. If Acrobat won’t do the job, chances are you can find
a plug-in or companion program to handle all you want to do with a PDF file.

For information related to Acrobat plug-ins and companion products, see Chapter 2.

What Is PDF?
PDF, short for Portable Document Format, was developed by Adobe Systems as a unique for-
mat to be viewed through Acrobat viewers. As the name implies, it is portable, which means
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5Chapter 1 ✦ Getting to Know Adobe Acrobat

the file you create on one computer can be viewed with an Acrobat viewer on other comput-
ers and on other platforms. For instance, you can create a page layout on a Macintosh com-
puter and convert it to a PDF file. After the conversion, this PDF document can be viewed on
a UNIX or Windows machine. Multi-platform compliance (to enable the exchange of files
across different computers, for example) is one of the great values of PDF files.

So what’s special about PDF and its multi-platform compliance? It’s not so much an issue of
viewing a page on one computer created from another computer that is impressive about
PDF. After all, such popular programs as Microsoft Excel, Microsoft Word, Adobe Photoshop,
Adobe InDesign, Adobe FrameMaker, and Adobe Illustrator all have counterparts for multi-
platform usage. You can create a layout on one computer system and view the file on another
system with the same software installed. For instance, if you have Adobe PageMaker installed
on a Macintosh computer and you create a PageMaker document, that same file can be
viewed on a PC with PageMaker running under Windows.

In a perfect world, you may think the capability to view documents across platforms is not so
special. Viewing capability, however, is secondary to document integrity. The preservation of
the contents of a page is what makes the PDF so extraordinary. To illustrate, suppose you
have a PageMaker document created in Windows using fonts generic to Windows applica-
tions. After it’s converted to PDF, the document, complete with graphics and fonts intact, can
be displayed and printed on other computer platforms. And the other computer platforms
don’t need the fonts or graphics to print the file with complete integrity.

This level of document integrity can come in handy in business environments, where soft-
ware purchases often reach quantum costs. PDF documents eliminate the need to install all
applications used within a particular company on all the computers in that company. For
example, art department employees can use a layout application to create display ads and
then convert them to PDF so that other departments can use the free Adobe Reader software
to view and print those ads for approval.

The benefits of PDF viewing were initially recognized by workgroups in local office environ-
ments for electronic paper exchanges. Today we have much more opportunity for global
exchange of documents in many different ways. As you look at Acrobat Professional and dis-
cover some of the new features now available for document review and markup, comparing
documents, support for layered files and preparing PDFs for screen readers, you’ll see how
Acrobat and PDF have evolved with new technologies.

Document repurposing
The evolution of the computer world has left extraordinary volumes of data on computer sys-
tems originally designed to be printed on paper. Going all the way back to UNIVAC, the num-
ber crunching was handled by the computer and the expression was the printed piece.
Today, forms of expression have evolved to many different media. No longer do people want
to confine themselves to printed material. Now, in addition to publishing information on
paper, we use CD-ROMs, the Internet, and file exchanges between computers. Sometimes we
use motion video, television, and satellite broadcasts. As high-speed access evolves, we’ll see
much larger bandwidths, so real-time communication will eventually become commonplace.
And the world of tomorrow will introduce more communication media. Think of outputting to
plasma, crystal, and holograms, and then think about having a font display or link problem
with one of those systems!
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6 Part I ✦ Welcome to Adobe Acrobat Professional

Technology will advance, bringing many improvements to bandwidth, performance, and
speed. To enable the public to access the mountains of digital data held on computer systems
in a true information superhighway world, files will need to be converted to a common for-
mat. A common file format would also enable new documents to be more easily repurposed,
to exploit the many forms of communication that we use today and expect to use tomorrow.

Acrobat Professional has added more tools for helping users repurpose documents. Tools for
repairing problem files, downsizing file sizes, porting them to a range of different devices, and
eliminating unnecessary data are part of the many features found in Acrobat Professional.

PDF and Adobe PostScript
The de facto standard of almost all printing in the graphics industry is Adobe PostScript.
Ninety-nine percent of North America and about seventy-five percent of the rest of the world
uses PostScript for all high-end output. Adobe developed this page description language to
accurately display the design created on your computer screen to the printed page. If graph-
ics and fonts are included in your files and you want to print the pages to high-end profes-
sional devices, then PostScript is the only show in town. The Adobe PostScript language was
responsible for the rise of so many software and hardware manufacturers. If you stop and
think about it, PostScript ranks up there with MS-DOS and Windows in terms of its installed
user base.

Okay, so how does PostScript relate to PDF? In the initial release of Acrobat, all PDF conver-
sion began with a file that was created as a PostScript file. Users selected the Print command
in an authoring program and printed the file to disk — thus creating a PostScript file. This file
was then opened in the Acrobat Distiller program and Distiller converted the PostScript to
a PDF.

Distiller is still a part of Acrobat. In some cases, creating a PDF from a PostScript file rather
than through any of the many other means available may be preferable. It could be that you
have a problem with exporting to PDF from a program, such as fonts not appearing embed-
ded, or you may need to create a PDF for a special purpose like printing and prepress. In such
circumstances using Acrobat Distiller may be your best solution for generating a PDF docu-
ment to properly suit the purpose.

For information related to printing PostScript files and using Acrobat Distiller, see Chapter 7.

Distiller’s use is waning a bit because now so many programs support PDF creation through
one-button clicks or using the Save As command. If a file export or other method creates good
PDF files, then you can bypass Distiller and use the application’s support for converting docu-
ments to PDF. Acrobat introduces more tools for converting files to PDF and there’s more sup-
port from authoring programs for PDF creation.

PostScript can be a problem solver for you and you may have an occasional need to use it
even if your workflow does not require its use all the time. The more you know about
PostScript and Acrobat Distiller, the more often you might be able to rescue problem files
that don’t seem to properly convert to PDF. In addition, if you use certain export features in
programs that support PDF creation, many of these programs use Acrobat Distiller in the
background to create the PDF file. You may not see the Distiller window, but it is working
away creating PDF files from some of your favorite programs. For these reasons, you should
take a look at Chapter 7, where I explain PostScript and Distiller in detail.

Cross-
Reference
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7Chapter 1 ✦ Getting to Know Adobe Acrobat

PDF versions
Acrobat is now in version 6. The version number indicates the number of releases of the
product. PDF is a file format and with it you’ll also find a version number. The PDF version
relates to the specifications of the file format, and for the end user it’s usually not so impor-
tant to understand all the specifications as much as it is to know what it does for you or what
you can expect from it. If you create PDF documents for users of older Acrobat viewers and
use the newer PDF format, your users may not be able to view your PDF files. Conversely, cre-
ating PDF files with the older version might prohibit you from using some newer features in
the recent release.

With PDF file conversion you have choices for creating and saving PDF documents with your
choice of version number. Depending on which version you select, you’ll have different speci-
fications assigned to the file. To give you an idea for how PDF format has changed, look over
Table 1-1.

Table 1-1: PDF Version Compatibility Differences

Acrobat 3.0 Acrobat 4.0 Acrobat 5.0 Acrobat Professional 6.0

Supports PDF  Supports PDF Supports PDF Supports PDF 
version 1.2 version 1.3 version 1.4 version 1.5

PDF files can be opened PDF files can be opened Minor viewing problems PDF files can be opened 
by Acrobat viewers 3.0 by Acrobat viewers 3.0 with  earlier viewers by Acrobat viewers 3.0 
and later. and later. may be experienced. and later.

Some viewing problems PDF files can be opened Some viewing problems
with earlier viewers may by Acrobat viewers 3.0 with earlier viewers may
be experienced. and later. be experienced.

Page size is limited to Page size is available Page size is available Page size is available  
45 inches × 45 inches. up to 200 inches × 200 up to 200 inches × 200 up to 200 inches × 200 

inches. inches. inches.

Document conversion is Document length is Document length is Document length is 
limited to 32,768 pages. limited only by RAM limited only by RAM limited only by RAM  

and hard drive space. and hard drive space. and hard drive space.

Color conversion Color conversion Color conversion Color conversion 
supports CalRGB. supports sRGB. supports sRGB. supports sRGB.

ICC Profile embedding ICC Profile embedding ICC Profile embedding ICC Profile embedding
supported. supported. supported. supported.

DeviceN color space is DeviceN color space is DeviceN color space is DeviceN color space
converted to an alter- supported. supported. with 32 colorants is
nate color space. supported.

Smooth shading is Smooth shading is Smooth shading is Smooth shading is
converted to images. supported. supported. supported.

Patterns display at 50% Patterns display accu- Patterns display accu- Patterns display accu-
but print correctly. rately and print correctly. rately and print correctly. rately and print correctly.

Continued
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8 Part I ✦ Welcome to Adobe Acrobat Professional

Table 1-1 (continued)

Acrobat 3.0 Acrobat 4.0 Acrobat 5.0 Acrobat Professional 6.0

Places halftone infor- Will only place halftone Will only place halftone Will only place halftone 
mation in the PDF. information when the information when the information when the 

Preserve Halftone infor- Preserve Halftone infor- Preserve Halftone infor-
mation is selected in mation is selected in mation is selected in 
the Color Job Options. the Color Job Options. the Color Job Options.

Preserve, remove, and Preserve, remove but Preserve, remove, apply Preserve, remove, apply 
apply Transfer functions NOT apply Transfer Transfer functions. Transfer functions.
are supported. functions 

Masks do not display Masks are supported in Masks are supported in Masks are supported in
or print properly. viewing and printing. viewing and printing. viewing and printing.

Photoshop 6.0 layers Photoshop 6.0 layers Photoshop 6.0 layers Photoshop 6.0 layers
and transparency not and transparency not and transparency sup- and transparency sup-
supported supported ported in Saves as PDF ported in Saves as PDF

from Photoshop only. from Photoshop only.

Illustrator 9.0 trans- Illustrator 9.0 trans- Illustrator 9.0 trans- Illustrator 9.0 trans-
parency is supported. parency is supported. parency supported parency supported 

in Save as PDF from in Save as PDF from
Illustrator only. Illustrator only.

Cannot embed Can embed Can embed Can embed 
double-byte fonts. double-byte fonts. double-byte fonts. double-byte fonts.

TrueType fonts cannot TrueType fonts can TrueType fonts can TrueType fonts can 
be searched. be searched. be searched. be searched.

Supports 40-bit Supports 40-bit Supports 40-bit Supports 40-bit 
encryption. encryption. encryption and encryption and 

128-bit encryption. 128-bit encryption.

PDF X/1-A and PDF X/3
are supported.

Support for Layers from
certain authoring
applications.

Table 1-1 lists a comparison of attributes of the different PDF versions and should not be con-
fused with certain features you can employ in one release that may make the PDF unusable to
users with earlier versions of Acrobat. For example, embedding movie clips in a PDF document
or using a JavaScript that won’t work in earlier versions is not a function of the PDF version.
Rather, they are features added to the program and employed after the PDF has been created.

One of the nice new features of Acrobat Professional with the current PDF version is support
for PDF/X files. If you work in the print industry, you’ll welcome the addition of PDF/X sup-
port. However, PDF/X is not supported with Acrobat Standard.

For information related to PDF/X, see Chapter 23.Cross-
Reference
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9Chapter 1 ✦ Getting to Know Adobe Acrobat

Acrobat Environment
Experienced Acrobat users will immediately notice a major change to the user interface (UI)
when Acrobat Professional is first launched. As a matter of fact, it might look pretty darn
crowded to you. There’s a lot to absorb when looking at the Acrobat window and you’ll need
some initial help to understand all the changes. Fortunately you bought this book and,
together with Adobe Systems and the new help features in all Acrobat viewers, I’ll walk you
through the many different items located in the Acrobat workplace.

Acrobat provides you with features such as menu commands, toolbars, and palettes to accom-
plish work for whatever purpose you hope to perform with PDF documents. When you launch
the program you see many of these features in the Acrobat window. Just so you know what is
being referred to when I discuss accessing a feature in Acrobat, take a look at Figure 1-1 to
understand the names used to describe the various areas of the new Acrobat workplace.

Figure 1-1: The Acrobat Professional workplace contains menus, toolbars, and palettes.
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10 Part I ✦ Welcome to Adobe Acrobat Professional

A Title Bar: By default the name of the file you open appears within parentheses in the
Title Bar. The title appearing in the Title Bar can change according to an option for dis-
playing the Document Title in the Open Options dialog box.

For information related to Open options and displaying document titles, see Chapter 3.

B Menu Bar: The Menu Bar contains all the top-level menu commands. These menu
choices are also available from various actions associated with links and form fields
when you choose the Execute Menu Item command in the Actions Properties dialog
box for links, form fields, and other features that permit associating an action with a
command.

For information related to link actions and the Execute Menu Item command action type, see
Chapter 15. For more information on actions with form fields, see Part VI.

C Toolbar: A number of individual toolbars are nested below the Menu Bar. The toolbar
noted in Figure 1-1 is the Zoom toolbar. Individual toolbars are marked with a vertical
separator bar at the left side of the toolbar. This bar can be selected and dragged to
move it out of the Toolbar Well.

For information related to working with toolbars, see the “Toolbars” section later in this
chapter.

D Toolbar Well: The Toolbar Well is the well that houses the toolbars. You can drag tool-
bars away from the Toolbar Well or add other toolbars and expand the Toolbar Well to
house your new additions.

E Palette Pull-Down menu: Individual tabs can be tucked away in the Navigation Pane
(see Navigation Pane later in this list) or appear anywhere in the Acrobat window. Each
palette contains its own menus accessible by clicking on the down-pointing arrow.
These menus are referred to as palette pull-down menus in all subsequent chapters.

F Bookmarks tab: The first of the default tabs appearing in the Navigation Pane is the
Bookmarks tab. If bookmarks are contained in the PDF document they will appear in
the palette when the palette is open, as shown in Figure 1-1.

For information related to creating bookmarks, see Chapter 15.

G Pages tab: Users of previous versions of Acrobat will notice there is no tab for Thumb-
nails. The Thumbnails tab has been renamed to the Pages tab. When you open the
Pages tab, you’ll see thumbnail images of each page in your document and you’ll find
many page editing features available to you from the Pages tab palette pull-down menu.

For information related to using many options available in the Pages tab, see Chapter 10.Cross-
Reference
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11Chapter 1 ✦ Getting to Know Adobe Acrobat

H Signatures tab: If digital signatures are included in your PDF document, they can be
viewed in the Signatures tab.

For information related to digital signatures, see Chapter 19.

I Layers tab: Acrobat supports layers that have been created from some authoring appli-
cations and exported as a PDF file with layers intact. The Layers tab enables you to
view or hide layers when they are present in the PDF.

For information related to working with Layers, see Chapter 17.

J Comments tab: A major overhaul has been made to the Comments tab. When you open
the Comments tab, the display of comments and reviews are shown horizontally at the
bottom of the Acrobat window.

To learn how to use the Comments tab options, see Chapter 14.

K Bookmarks: Figure 1-1 shows the Bookmarks tab opened with a display of bookmarks
contained in the palette. Bookmarks enable you to jump to the page or view of the
associated bookmark. In addition, you can assign attributes other than views to book-
marks with action items such as opening/closing files, running a menu command,
invoking a JavaScript, and many other actions.

For information related to link actions associated with bookmarks, see Chapter 15.

L Navigation Pane: The Navigation Pane can be expanded or collapsed. The view in
Figure 1-1 is an expanded view where the Bookmarks tab is the active palette. To open
the Navigation Pane you can click on a tab to display the respective information associ-
ated with that tab in the expanded palette window. Clicking again on the tab collapses
the view. You can also use the keyboard modifier F6 to expand and collapse the
Navigation Pane.

M Document Pane: The Document Pane is the container for PDF files you see in Acrobat.
When no file is open, the Document Pane is empty. When you open a PDF document,
the document is viewed in the Document Pane.

N Status Bar: The Status Bar contains some viewing and navigation tools and displays
information about your PDF document. You can see the page size and the number of
pages in the open PDF at a glance in the Status Bar as shown in Figure 1-1 where page 2
of 620 is displayed. You can navigate pages in the status bar by clicking on a navigation
tool, entering a number in the Status Bar, and pressing Enter/Return on your keyboard.
You can change page views by selecting one of the three tools on the far right side of
the Status Bar.

For information related to navigation with the Status Bar, see Chapter 3.Cross-
Reference
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12 Part I ✦ Welcome to Adobe Acrobat Professional

O How To window: The How To window is a new addition to Acrobat 6. The How To win-
dow enables you to perform searches and to obtain instant help with menu commands,
tools, palette options, and many selected tasks you perform routinely.

For information on using the How To window, see the “Getting Help” section later in this
chapter.

For more detail on specific menu commands, tools, and palettes, see the chapters associated
with the different options available to you. Each of the items discussed here is explained in
more depth in subsequent chapters.

Menus
As with any program operating on a computer system that supports a windows type of envi-
ronment, you’ll notice menu commands at the top level of the Acrobat window. For users of
previous versions, you’ll notice different menu commands have been relocated under differ-
ent menu headings. If at first glance you don’t see an option you used in Acrobat 5, poke
around the menus. None of the Acrobat 5 features have been eliminated; they may just be in a
different place or referred to by a different name. As you browse through the menus, you can
see some changes in the UI where some menu commands now contain an icon adjacent to a
menu name to help you easily access the desired command.

File menu
The File menu is where you open/close documents, create PDF files, import and
export certain data, access print commands, and use some other nifty new addi-

tions in Acrobat Professional. A distinction between the Mac and PC version is the location of
recently viewed documents. On the Mac in OS X you’ll find recently viewed documents
located under the Open Recent File command. Accessing the command opens a submenu
where recent documents can be accessed. On Windows, you’ll find the recently viewed docu-
ments located at the bottom of the File menu as shown in Figure 1-2.

Upload for Browser-Based Review and Go Back Online is available only in Acrobat Professional.
Export Comments to Word is available only in Acrobat Professional on Windows XP.

You’ll note the Open as Adobe PDF command formerly used in Acrobat 5 is now named
Create PDF. A submenu offers you choices for converting different file types to PDF. A new
command titled Open My Bookshelf enables you to organize a library of eBooks and access
them easily. Also notice there is a new command in the File menu for exporting comments to
Word. Other new commands include saving a certified document, reviewing tracking, reduc-
ing file sizes, and printing online.

For information related to converting files to PDF, see Chapter 5. For information on eBook
libraries, see Chapter 22. For more information on commenting and review tracking, see
Chapter 14. For more information on reducing file sizes, see Chapter 13. For more informa-
tion on online printing see Chapter 23.
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13Chapter 1 ✦ Getting to Know Adobe Acrobat

Figure 1-2: Recently opened files in Windows
appear listed at the bottom of the File menu.
Macintosh users can display a list of recently
viewed files by selecting the Open Recent File
command under the Acrobat menu to the left
of the File menu.

Edit menu
The traditional Cut, Copy, and Paste commands are located in the Edit menu along
with other familiar commands from Acrobat 5. One new command and a very nice

feature in Acrobat is the Look Up Definition command. The menu option changes the word(s)
within quote marks according to the last word you entered in the Search window. When you
select the command, your Web browser is immediately launched and takes you to
Dictionary.com (presuming you have an active Internet connection). Click the lookup button
on the Web site and you can read the definition for the searched word. Very cool!

The default menu command is Look Up Definition. When a word is highlighted, the menu
command changes to Look Up “word,” where word is the highlighted word. In Figure 1-3, 
I highlighted ICC; thus, the menu command reads: Look Up ICC. Preferences on the
Macintosh are available from the Acrobat menu.

Note
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14 Part I ✦ Welcome to Adobe Acrobat Professional

Figure 1-3: The Edit menu contains many of the same
menu commands found in Acrobat 5. The new Look
Up Definition command enables you to search a Web
site for a word definition.

View menu
The View menu, shown in Figure 1-4,  contains all the commands you’ll use for
viewing PDF documents. If you are familiar with Acrobat 5, you can see many

changes in the View menu for items introduced in Acrobat and some rearrangement for items
you may have used previously. Additions to the View menu include items such as Task
Buttons, Automatic Scrolling, Rulers, Comments List, and Review Tracking.

Grids, Guides, and Rulers are only available in Acrobat Professional.

For information related to Automatic Scrolling, see Chapter 18. For more information on
Rulers, see Chapter 10. For more information on Comments and Review, see Chapter 14.

Cross-
Reference
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15Chapter 1 ✦ Getting to Know Adobe Acrobat

Figure 1-4: The View menu contains commands
you’ll use for viewing PDF documents and
navigating through pages and different PDF files.
The menu commands have many additions for
new features appearing in Acrobat Professional.

Document menu
The Document menu, shown in Figure 1-5,  contains a collection of com-
mands specific to document handling. Many review and markup features

are located as commands in the menu as well as some new features such as adding headers
and footers, adding watermarks, and preflighting PDF files before sending them off to service
centers for printing. You’ll also find the Paper Capture command here and digital signature
handling.
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16 Part I ✦ Welcome to Adobe Acrobat Professional

Figure 1-5: The Document menu contains
commands for review and comment. New
features such as adding headers and footers,
adding watermarks, and preflighting PDFs are
located in this menu.

Compare Comments and Preflight are available only in Acrobat Professional. Export
Comments to Word is available only in Acrobat Professional running on Windows XP with
Microsoft Office XP.

For information related to review and comment, see Chapter 14. For information related to
adding headers, footers, and watermarks, see Chapter 10. For information on digital signa-
tures, see Chapter 19. For information on preflighting PDFs, see Chapter 23.

Tools menu
The Tools menu in Acrobat logically places all your editing tools in a single con-
venient place (Figure 1-6). You can access certain tools from the Acrobat

Toolbars (explained later in this chapter) or you can browse the submenus and access a com-
mand, and the respective toolbar appears in the Acrobat window. Users will immediately
notice the default navigation tools are not all visible in the Acrobat Toolbar Well. If you want
to see the Navigation tools you’re familiar with, open the Tools menu and select Navigation
tools from the submenu. From the menu options, select Show Navigation Toolbar. Each of the
submenus contains similar commands all located at the bottom of each submenu. When you
make the selection, the toolbar you chose opens in the Acrobat window. One of the new sets
of tools in this menu is the Measuring tools set. Acrobat Professional offers you tools to mea-
sure distances, compound distances, and areas within a PDF document page.

Measuring tools are only available in Acrobat Professional.

For information related to the measuring tools, see Chapter 10. For more information on
showing and hiding toolbars, see the “Toolbars” section later in this chapter.

Cross-
Reference

Note

Cross-
Reference

Note
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Figure 1-6: The Tools menu contains a collection of
tools that can be accessed from submenus. Select a
tool group from the menu options to open a
submenu.

Advanced menu
The Advanced menu in Figure 1-7 contains a collection of menu com-
mands considered to be advanced Acrobat features. You won’t find any

of these tools in the Acrobat Standard software. You’ll also notice many commands in this
menu have been relocated from other menus in earlier versions of Acrobat. In the Advanced
menu you’ll find access to Distiller and Catalog, JavaScript commands, the Web capture tool,
the PDF Optimizer, access to the Forms tools, and a host of view options for prepress and
printing. You’ll also notice more commands here for digital signatures. Because digital signa-
ture authentication is now handled by Adobe Reader and Acrobat Standard, some of the digi-
tal signature commands are contained in the basic tools area that shares these commands
with the other viewers. For advanced operations only accessible to Acrobat Professional,
these menu commands nest in the Advanced menu.

Figure 1-7: The Advanced menu offers menu
commands related to advanced features that
are only available to Acrobat Professional
users.
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Batch Processing, Catalog, Forms, JavaScript, PDF Optimizer, Proof Setup, Proof Colors,
Separation Preview, and Transparency Flattener Preview are only available in Acrobat
Professional.

For information related to digital signatures, see Chapter 19.

Window menu
The Window menu in Acrobat has been polished since Acrobat 5 and some
of the menu commands from earlier versions of Acrobat have been elimi-

nated from this menu, such as various palette accesses, toolbar access, and accessibility. The
menu now deals primarily with window viewing options, and a new feature in Acrobat offers
you a split window view like you might see in word processing and spreadsheet programs. All
the open documents in the current Acrobat session are still found at the bottom of this menu
as shown in Figure 1-8.

Figure 1-8: The Window menu handles all the
window views such as tiling, cascading, and the
new feature for displaying a split window.

For information related to Window views and the split window view, see Chapter 3.

Help menu
The traditional help files added to your Acrobat folder at installation can be found
in the Help menu, shown in Figure 1-9. But Acrobat contains a new help system

with the addition of How To menus available in all Acrobat viewers. The How To menus can
easily be accessed from the Help menu or when the How To window is open in the Document
Pane. You also find online services from Adobe Systems in the menu and a new addition for
examining your computer system.

For information related to Help and How To menus, see the “Help” section later in this
chapter.

Cross-
Reference

Cross-
Reference

Cross-
Reference

Note
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Figure 1-9: The Help menu gives you access to
the Help PDF files installed with Acrobat and a
new feature in Acrobat Professional enables you
to search for a help topic instantly via the new
How To menu commands.

Submenus
An extensive number of submenus are contained in each of the menus shown previously. A
submenu is denoted in Acrobat by a right-pointing arrow on the right side of a given menu
command. Select a command with one of these arrows adjacent to the command name, and a
submenu opens. In a few cases you can find nested submenus where another right-pointing
arrow may be visible in a given submenu command as shown in Figure 1-10. If you want to
access the second submenu, move the cursor to the menu option containing a right-pointing
arrow. To make a selection from a submenu command, move the cursor to the desired menu
command. When the menu command highlights, click the mouse button to execute the
command.

Figure 1-10: To access a submenu, move the cursor to the command containing a 
right-pointing arrow and slide the cursor over to the submenu options. Click on the
desired command in the submenu to execute the command.
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Context menus
Wherever you are in the Acrobat window — the toolbars, palettes, Document Pane, or the
How To menus — you can gain quick access to menu items related to your task by opening a
context menu. Context menus pop up in an area where you either click the right button on
the mouse or use an appropriate key modifier. In Windows, right-click the mouse button to
open a context menu. On a Macintosh, press the Control key and click the mouse button.
Context menu options relate to the particular tool you have selected from a toolbar. By
default the Hand tool is selected when you open Acrobat and open a PDF document. When
you right-click the mouse button (Windows) or Control+click (Macintosh), a context menu
pops up where you click the mouse as shown in Figure 1-11.

Figure 1-11: With the Hand tool selected, right-clicking (Windows) or Control-clicking
(Macintosh) the mouse button opens a context menu. From the menu, scroll the list and
select the desired menu command.

If you change tools in a toolbar and open a context menu, the menu options change to reflect
choices with that particular tool. Likewise a context menu opened on a palette offers menu
options respective to the palette, as shown in Figure 1-12.

In order to open a context menu on a palette, the palette must be open in the Navigation
Pane. Clicking on the tab for the palette name won’t open a context menu.

Note
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You’ll find context menus to be a great benefit during your Acrobat sessions and using them
helps you work much faster. Throughout this book I often make references to the different
choices you have in selecting a tool or command. In most references you find mention of con-
text menus. Be certain you know how to open a context menu in Acrobat on your computer,
because the fact that a menu option is contained in a context menu is mentioned without
walking you through the steps to open the context menu.

Figure 1-12: When a palette is open in the Navigation Pane and you open a context menu,
the menu options reflect tasks you can perform respective to the palette.

Keyboard modifiers
Pressing one or more keys on your keyboard can also open menus and invoke different com-
mands. When you become familiar with key modifiers that perform the same function as
addressing a menu or context menu, you’ll find yourself favoring this method for making dif-
ferent menu selections or grabbing a tool from a toolbar. Fortunately, you can learn as you
work when it comes to memorizing keyboard shortcuts. As I’m certain you know, several key
modifier combinations are noted in menu commands. You can learn these shortcuts when
you frequently address a particular command. However, the keyboard modifiers you see in
the menu commands are just a fraction of what is available in Acrobat for quick access to
commands and tools. For a complete list of all keyboard modifiers, look over Appendix B.
Mark the pages and use them as a reference when you want to learn more key combinations
for work you frequently do in Acrobat Professional.
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Pressing a single key to access a tool requires you to have your Preferences set to accept sin-
gle keystroke shortcuts. See the Steps for Setting Up the Acrobat Environment later in this
chapter for proper preference settings.

Toolbars
Tools are grouped together in separate toolbars in the Toolbar Well below the Menu Bar. The
default view when you launch Acrobat contains several toolbars visible in the Toolbar Well.
You can remove various toolbars and undock (remove) them, move them around the Acrobat
window, close them, and add different toolbars not visible when you open the default view.
The Toolbar Well where the toolbars are contained can be collapsed and expanded according
to the number of toolbars you add to it.

Default toolbars
When you launch Acrobat for the first time or you set the toolbars to default view, five differ-
ent toolbars are docked in the Toolbar Well. The default toolbars include

✦ File tools. These tools shown in Figure 1-13 are used for general document handling.
The File tools activate commands for Open, Open Web Page, Save, Print, and Search.

Figure 1-13: The File tools toolbar contains
tools for document handling, such as opening
PDF documents, saving documents, and
printing files.

✦ Task tools. Task tools are used for editing tasks and document handling. The tools han-
dle features such as Create PDF, Review and Comment, Security, Digital Signatures, and
opening the Advanced Editing tools. All of these tools have toolbar pull-down menus.
Notice in Figure 1-14 the down-pointing arrow appearing to the right of all the tools in
this group indicating that they all have pull-down menus.

Figure 1-14: The Tasks tools contain tools used for file editing.

✦ Basic tools. Among the Basic tools are the Hand tool, text and graphics selection tools,
and the Snapshot tool (Figure 1-15). Below the default Select Text tool you’ll find other
selection tools from the pull-down menu.

Figure 1-15: The Basic tools contain tools
for selecting text and graphics. The default
Hand tool is selected when you open
Acrobat at the start of each session.

Note
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✦ Zoom tools. All the zooming in and out of the Document Pane can be handled in the
Zoom tool group shown in Figure 1-16.

Figure 1-16: The Zoom tools handle zooming in
and out of the current active document.

✦ How To tool. Help topics are readily available to you in Acrobat via the How To window
shown in Figure 1-17. A list of How To items is contained in the pull-down menu as well
as access to the complete Help document.

Figure 1-17: The How To tool enables you to obtain help for many
common editing tasks in Acrobat.

✦ Rotate tools. These tools rotate document pages clockwise and counterclockwise in 
90-degree rotations. The rotations you make with these tools are for temporary viewing
purposes only. The views cannot be saved after rotating pages with these tools, shown
in Figure 1-18.

Figure 1-18: The Rotate tools provide options for rotating pages
clockwise or counterclockwise.

Managing default toolbars
As mentioned previously, toolbars can be moved, docked and undocked from the Toolbar
Well. Here’s a list of some of the things you can do with the default toolbars and any other
toolbars you decide to view:

✦ Undocking toolbars. Toolbars can be relocated from within the Toolbar Well to another
area within the Acrobat window. For example, you might find it more convenient to
move a toolbar you frequently access during an editing session so it is positioned at
the bottom of the Document Pane. If so, just place the cursor on top of the vertical line
adjacent to the first tool in a toolbar and drag it away from the Toolbar Well as shown
in Figure 1-19. This vertical line is the hot spot used to select the toolbar instead of a
tool in the group. Clicking anywhere else in the toolbar selects a tool.

✦ Docking toolbars. To dock a toolbar back in the Toolbar Well after it has been
removed, drag the toolbar, again by the vertical line adjacent to the first tool, on top of
the Toolbar Well. The toolbar snaps to an available position in the toolbar. If you drop
the toolbar between two other toolbars, the toolbar you relocate to the Toolbar Well
snaps in position between the two docked toolbars.

Toolbars can also be docked vertically on the left and right sides of the Document Pane
and at the bottom of the Acrobat window below the Status Bar. For example, if you drag
a toolbar to the left of the Navigation Pane and release the mouse button, the toolbar
snaps to a docking station and the tools display vertically.  
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Figure 1-19: Move toolbars around the Acrobat window by selecting the vertical line
adjacent to the first tool in the toolbar and dragging it away from the Toolbar Well.

You can dock a toolbar using a menu command instead of dragging the toolbar. Open a
context menu on an undocked toolbar and select Dock in Toolbar Well. The toolbar
docks back in the Toolbar Well.

For more information on docking toolbars vertically and below the Status Bar, see Chapter 3.

✦ Resetting toolbars. You can position toolbars all over the Acrobat window and return
them to the default positions. This is particularly helpful if multiple users work on a
single computer. Your view of where the toolbars are located may not be the desired
view for another user. In such cases you can reset the toolbars to defaults. To set tool-
bars to defaults, open a context menu from any toolbar by right-clicking (Control+click-
ing in Macintosh) and selecting the menu item Reset Toolbars as shown in Figure 1-20.

Only a single toolbar can be selected at a time. If the Toolbar Well is visible, opening a con-
text menu from the Toolbar Well provides the same menu options as opening context menus
from the toolbars. If all toolbars are removed from the Toolbar Well, the Toolbar Well disap-
pears. If the Toolbar Well is not visible, you need to open a context menu on a toolbar to
reset the toolbars to default views.

Note

Cross-
Reference
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Figure 1-20: To return toolbars to the default view, open a context menu on any toolbar
and select Reset Toolbars from the menu options.

✦ Hiding all toolbars. Toolbars can be hidden from view to offer you more room when
editing a PDF document or browsing the contents of PDFs. If you master some of the
keyboard shortcuts shown in Appendix B, you can move about PDF files in the
Document Pane or perform many different editing tasks without the toolbars in view.
To hide the toolbars from view, open a context menu on any toolbar and select Hide
Toolbars. When toolbars are hidden you won’t have access to a context menu to get
the toolbars back in view. Press the F8 key on your keyboard and all toolbars reappear.
The F8 key can also hide toolbars.  It is to your benefit to remember to use the key-
board shortcut so you become familiar with turning the view back on.

✦ Hiding a single toolbar. You can hide a toolbar once it has been undocked from the
Toolbar Well. Click on the X in the top-right corner of the toolbar to close and it disap-
pears from view. From a context menu opened on any toolbar you can open the toolbar
and display it in the Acrobat window again.

✦ Locking toolbars. The vertical line used to remove a toolbar from the Toolbar Well dis-
appears when you select Lock Toolbars from a context menu. The toolbars cannot be
inadvertently moved once you lock them. To unlock the toolbars, open a context menu
and select Lock Toolbars again. The checkmark along side the menu command will be
unchecked and show the toolbars unlocked in the Toolbar Well.  If the toolbars are
locked and you drag an undocked toolbar on top of the Toolbar Well, it won’t dock. You
need to first unlock the toolbars before you can redock them.
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You can also lock toolbars that are undocked outside of the Toolbar Well. The docking arm
on the toolbar disappears on undocked toolbars the same as it does for toolbars docked in
the Toolbar Well. However, locking undocked toolbars does not prevent you from moving
them around the Acrobat window. You can grab the title bar for any undocked tool bar and
move it to another location.

✦ Setting new toolbar defaults. If you decide to reposition your toolbars and want to
keep them fixed as new defaults, Acrobat can do so for you automatically. Move the
toolbars to the desired locations and go about your work. When you quit Acrobat and
reopen the program, the toolbar positions remain as you last arranged them.

Understanding advanced toolbars
The default toolbars represent less than half of the tools available to you in Acrobat
Professional. Many of the other toolbars remain hidden from view. The reason for this is obvi-
ous when you load all the toolbars in the Toolbar Well. You’ll lose a lot of viewing real estate
when all toolbars are docked in the Toolbar Well as shown in Figure 1-21. Unless you have a
large display monitor or a second monitor, working on a file in the Document Pane when all
toolbars are in view can be difficult. Fortunately, by managing the toolbars you can elect to
show only the tools you want to work with and you can move them around the Acrobat win-
dow allowing for the best view.

Figure 1-21: The first two rows contain the toolbars shown at the default view. The four
rows following are toolbars added from menu commands.

Note

03 540475 Ch01.qxd  9/4/03  10:01 AM  Page 26



27Chapter 1 ✦ Getting to Know Adobe Acrobat

You open toolbars from menu commands in the Tools menu or by opening a context menu. If
you’re a seasoned Acrobat user, your first encounter with Acrobat Professional might be a bit
frustrating if you don’t know how to access the tools you want to use. “Where is that Form
tool?” you may ask. Don’t worry; it’s there. You just have to poke around and search for it, or
better yet, look over the following descriptions to understand more about how these other
tools are grouped into separate toolbars.

Acquiring advanced toolbars
For the purpose of discussion I’ll refer to the non-default toolbars as advanced toolbars.
Acrobat does not refer to all these tools as advanced tools. Some of the tools are noted in the
menu commands by categories without the mention of being an advanced tool. For clarity
though, consider all the following toolbars as advanced toolbars. 

You can use two methods for displaying a toolbar not visible when you open Acrobat. You
can visit the Tools menu where you find a list of tools with submenus. Select a menu item to
display the toolbar outside the Toolbar Well as a floating toolbar. In some cases you can find
nested submenus and may need to search around for a given toolbar. The other method for
accessing these tools is to open a context menu. A number of toolbars appear as menu selec-
tions. When a checkmark is not displayed adjacent to the toolbar name, the toolbar is not vis-
ible in the Acrobat window.

Advanced Commenting tools
When you open either the View and Toolbars submenu menu or a context menu on the
Toolbars Well, the first menu option is Advanced Commenting. Select the menu option and a
submenu opens with Comment tools used for review and comment. If you select Show
Advanced Commenting Toolbar at the bottom of the menu, the Advanced Comment tools
open in their own toolbar as shown in Figure 1-22.

Figure 1-22: Choose Tools ➪ Advanced Commenting ➪ Show 
Advanced Commenting Toolbar or open a context menu on the 
Toolbar Well and select Advanced Commenting to open the 
Advanced Commenting toolbar.

Down arrows in the toolbar are noted where pull-down menus can be opened. Click on a pull-
down menu and various other tools appear as additional choices. When you click the down
arrow to open a pull-down menu adjacent to the Rectangle tool, the menu options show sev-
eral new Drawing tools introduced in Acrobat.

The Arrow tools, the Cloud tool, and the Polygon tools are new additions to Acrobat. At the
bottom of the menu you again have an option to show these tools in a separate Drawing tool-
bar as shown in Figure 1-23.

The Cloud tool is available only in Acrobat Professional.Note
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Figure 1-23: Selecting the Show Drawing Toolbar menu command opens 
another toolbar where the drawing tools are contained in their own group.

A down-pointing arrow appears to the right of the Pencil tool. When you click on the arrow a
pull-down menu opens and the option at the bottom of the menu commands is Expand This
Button. Instead of opening another toolbar, the Advanced Commenting toolbar expands and
shows another new tool introduced with Acrobat. You can use the Pencil Eraser tool to erase
lines or part of a line drawn with the Pencil tool.

The last pull-down menu opens the Attach toolbar where file and sound attachment tools are
found, as shown in Figure 1-24. Another tool new to Acrobat appears in this toolbar. The
Paste Clipboard Image tool on the far right side of the toolbar attaches the data you copy to
the clipboard.

Figure 1-24: Expanding the Attach toolbar
displays the Attach Sound and Paste
Clipboard tools.

Notice the hierarchy of how these tools are positioned and how to open them. When you
select a toolbar in the Tools menu or from a context menu, you don’t immediately have
access to the nested toolbars. You need to remember to open a toolbar and then open the
pull-down menus to expose more toolbars.

To learn how to use each of the Advanced Commenting tools, see Chapter 14.

Commenting tools
The Commenting tools appear a little farther down the menu selections in the Tools menu
and the Toolbars context menu. When you open the Commenting toolbar you’ll see many of
the Comment tools that were available in the last version of Acrobat. The familiar Note, Text
Commenting, Stamp, and Highlighting tools are all found in the Commenting toolbar as shown
in Figure 1-25.

Text Edit tools are available only in Acrobat Professional running in Windows.

The Text Edit tools are new tools introduced in Acrobat Professional as you can see in Figure
1-25. The tools include: Insert Text at Cursor, Highlight Selected Text, Add Note to Selected
Text, and Replace Selected Text. The tools are used to export comments to Microsoft Word
files when using Office XP running in Windows XP. Changes have also been made to the Stamp
tool where creating custom stamps has been simplified and managing stamp libraries has
been changed. Various tool selections are all made from pull-down menus in the Commenting
toolbar. The only subtoolbar that can be opened from the Commenting tools is the Highlight
toolbar. When you select the pull-down menu for the Highlight tool on the far right side of the
Commenting toolbar, a command exists to open the Highlighting toolbar. These tools are the
same as the Highlight tools found in Acrobat 5.

Note

Cross-
Reference
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Figure 1-25: Selecting Commenting from the Tools 
menu or a context menu opens the Comment tools. 
Open the pull-down menu to view the Text Edit tools.

Using the Commenting tools is covered in Chapter 14.

Advanced Editing tools
Advanced Editing tools contain the TouchUp tools, Article tool, Crop tool, Link tool, Movie
tool, and Sound tool. The behavior of these tools is similar to how they were used in Acrobat
5. The most radical change exists with the Form tools that are located within this toolbar. If
you select the pull-down menu in the Advanced Editing toolbar adjacent to the Button tool,
the remaining Form tools are exposed as shown in Figure 1-26. You can also break these tools
away and display them in their own toolbar by selecting Show Forms Toolbar.

Figure 1-26: Open the Forms toolbar by
selecting the pull-down menu adjacent to the
Button tool and selecting Show Forms Toolbar.

The Form tools experienced the most obvious changes among the Advanced Editing tools.
When you open the Forms toolbar or select a Form tool from the pull-down menu, you imme-
diately have choices for what form field you want to create. No longer does the Field
Properties dialog box open when a field is added to the page. For more options as you create
fields you can open the Properties Bar by opening a context menu in the Toolbar Well and
selecting Properties Bar. The Properties Bar, as shown in Figure 1-27, enables you to set some
field properties such as field names, appearances, fonts, and point sizes. Additional proper-
ties are established by opening a context menu on the field you create and selecting
Properties or clicking on the More button in the Properties Bar.

For complete descriptions of the Advanced Editing tools see Part IV. For information on using
the Form tools, see Chapter 25.

Cross-
Reference

Cross-
Reference
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Figure 1-27: The Acrobat Professional Properties Bar enables you to set some 
field properties without opening the Field Properties dialog box.

Basic tools
The first of the Basic tools shown in the Basic Tools toolbar is the Hand tool followed by the
Select Text tool as shown in Figure 1-28. A new tool added in Acrobat Professional is the
Snapshot tool. When you select the Snapshot tool and click on a page in the Document Pane
or click and drag to open a rectangle with a selection marquee, the area is copied to the clip-
board and the tool takes a snapshot of the page or selection. From there you can create a new
PDF file or a link to the snapshot.

Figure 1-28: The Basic tools contain the
Hand tool, Selection tools, and the
Snapshot tool.

Selection tools
You can open another toolbar that contains the various selection tools by opening the pull-
down menu and selecting Show Selection Toolbar. The toolbar opens with the Text Select,
Select Table, and Select Image tools as shown in Figure 1-29. These tools are available to both
Windows and Macintosh users.

Figure 1-29: The Selection toolbar contains
tools for text, table, and image selections.

To understand how to use the Selection and Snapshot tools, see Part III.

Measuring tools
A new feature added to Acrobat with Acrobat Professional is the ability to measure distances
on a document page. You have three different tools for measuring in the Measurement tool-
bar. When you select Measuring from the Tools menu or a context menu, the Measuring tool-
bar opens as shown in Figure 1-30.

Figure 1-30: The Measuring toolbar offers
three tools to measure distances and areas
on a PDF page.

Cross-
Reference
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The tools include the Distance tool for measuring linear distances, the Perimeter tool for
measuring linear distances of angles and objects, and an Area tool for measuring the surface
area of objects. Tools such as these might be used for examining measurements in engineer-
ing drawings.

For more information related to using the measuring tools, see Chapter 17.

Navigation tools
The most obvious change for previous users of Acrobat when they open any Acrobat 6.0
viewer with the default toolbars in view is the absence of the Navigation tools. These familiar
tools are accessible in their own toolbar via the Tools menu or a context menu. Because so
many different ways exist to page through PDF files, having the Navigation tools visible as a
default isn’t really necessary. The Status Bar contains all but the Go to Previous View and Go
to Next View tools, and you can access these commands through keyboard shortcuts and
other menu commands. If you want to use the navigation tools, shown in Figure 1-31, you can
open the toolbar and click on the Navigation buttons.

Figure 1-31: The Navigation toolbar is not visible when Acrobat
opens with default toolbars in view. To access the Navigation 
tools, select Show Navigation Toolbar from the Tools menu or 
a context menu.

For more information regarding navigating PDFs, see Chapter 3.

Zoom tools
The Zoom toolbar is a default toolbar that is also accessible from the Tools menu and a con-
text menu. The familiar zoom and page views are contained in this toolbar as well as new
additions to the way you can zoom in on documents in the Document Pane. Acrobat
Professional offers you two more zoom tools that will be much appreciated by users who
have experienced long waiting periods for screen refreshes.

When you open a pull-down menu adjacent to the Zoom tool, options for Dynamic Zoom, the
Loupe tool, and the Pan and Zoom window are shown as menu options in addition to the
familiar Zoom In and Zoom Out tools as shown in Figure 1-32. These new tools enable you to
inspect smaller or larger portions of PDF pages without having to zoom in and out of the
entire page. If your document pages take a long time to refresh the screen, you’ll find these
tools to be a big help in navigating through documents.

The Loupe tool and the Pan & Zoom Window are available only in Acrobat Professional.

For more information regarding the use of the new Zoom tools, see Chapter 3.Cross-
Reference

Note

Cross-
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Figure 1-32: The new Zoom tools — Loupe,
Dynamic Zoom, and Pan & Zoom — help you
view PDF pages much faster.

Customizing the Acrobat workplace
Whether you’re an Acrobat pro or a new Acrobat user, seeing all those toolbars scattered
across the Toolbars Well the first time can be very intimidating. As you poke around and pos-
sibly feel a little frustration trying to identify the right tool icon to select the right tool for the
task at hand, please realize that Acrobat is a multifaceted program serving a huge array of
needs for different users. Not all the tools and features are intended for use in a single
Acrobat session. You may be a PDF forms author and need only Basic tools, Navigation tools,
and Form tools. In another session you may be a reviewer and only have need for the Review
and Comment tools. You might be an eBook author and need to work with many new features
for creating and viewing eBooks or you might want to edit PDF pages and post modified PDFs
on your Web site.

When learning all the tools and commands contained in Acrobat Professional, be certain to
look over all the chapters where tools are discussed. Learn how to access toolbars and orga-
nize them in the Toolbars Well. When you begin a new Acrobat session, set up your environ-
ment so you can easily select a tool from toolbars you dock in the Toolbar Well. Frequently
return to Table 1-1 and look over the keyboard shortcuts to learn how to quickly access the
tools you use most frequently.

As a starting point, you can configure Acrobat to provide you with immediate feedback
related to tools selection and keyboard shortcuts. As you first start using Acrobat
Professional, follow the steps in the next section to help you customize your environment for
more efficient editing and less frustration. In this example, an environment for a PDF forms
designer is set up. You can change the toolbars to meet needs in review and markup or PDF
creation, or add tools for some other kind of work you do.

STEPS: Setting up the Acrobat environment
1. Return to toolbar defaults. If you moved toolbars around, added toolbars to the

Toolbar Well, or changed the view from any defaults, start by resetting the toolbars.
Position the cursor on any toolbar or an empty area in the Toolbar Well and right-click
to open a context menu (Ctrl+click for Macintosh) and select Reset Toolbars.

2. Show a toolbar. Open the Tools menu and select the first toolbar you need to add to
the Toolbar Well for easy access to the tools you intend to use. In this example, I select
Tools ➪ Advanced Editing ➪ Forms ➪ Show Forms Toolbar as shown in Figure 1-33.

3. Dock the toolbar in the Toolbar Well. Click the Title Bar of the toolbar floating in the
Acrobat window and drag it toward the Toolbar Well. As you arrive at the bottom of the
Toolbar Well, you should see a black horizontal line appear. When you see the line,
release the mouse button. The toolbar is now docked in the Toolbar Well.
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If at first you don’t see a black horizontal line when the toolbar is moved to the bottom of the
Toolbar Well, don’t be concerned. If the toolbar you drag is moved anywhere on the Toolbar
Well and you release the mouse button, the toolbar will dock.

Figure 1-33: Open the Tools menu and select a toolbar to be viewed in the Acrobat
window.

4. Add toolbars for tools you intend to use. If you need more tools, follow the previous
steps and add just the toolbars containing the tools you expect to use in your editing
session. In this example I open a context menu on a toolbar in the Toolbar Well and
select the Properties Bar. The Properties Bar will be useful when I work with the Forms
tools.

5. Open the Preferences dialog box. As a new user to Acrobat Professional, you want as
much feedback from Acrobat as you can get in regard to the tool names and keyboard
shortcuts. You learn as you frequently access a tool. In the Preferences dialog box,
Acrobat offers different options for displaying Tool Tips and keyboard shortcuts. To
open the Preferences dialog box press Ctrl+K in Windows or Ô+K in Macintosh.

You can also access Preferences by opening the Edit menu and selecting Preferences in
Windows or opening the Acrobat menu and selecting Preferences in Mac OS X.

6. Set Viewing preferences. Click General in the left pane of the Preferences dialog box. In
the right pane open the pull-down menu for Show tool and property button labels and
select All labels from the Menu options as shown in Figure 1-34. Check the box for Use
single-key accelerators to access tools. Click OK to return to the Acrobat window.

When you select All labels, Acrobat displays each tool in the toolbars with an icon and a
name. When you check the box for Use single-key accelerators to access tools, you can press
a key on your keyboard to access a tool respective to the shortcut.

Note

Note

Note
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Figure 1-34: Open the Preferences dialog box by pressing Control+K in Windows
or Ô+K in Macintosh. Select the preference category in the left pane and make
preferences choices in the right pane.

7. Open a PDF document. PDF files are opened via a menu command by clicking on the
Open tool or by pressing keyboard shortcuts. You can choose File ➪ Open, click on the
Open tool in the top-left corner of the Toolbar Well, or press Control+O for Windows or
Ô+O for Macintosh. Navigate to your hard drive in the Open dialog box and select the
file to open. After selecting the file, click on the Open button. (You can also double-click
on a filename in the Open dialog box to open the file.)

8. Open a Tool Tip. When you place the mouse cursor directly over a tool, a pop-up
Tool Tip opens as shown in Figure 1-35. Note the Tool Tip displays the name of the tool
and the keyboard shortcut that can be used to access the tool. In this example the cur-
sor is placed over the Button tool. The keyboard shortcut to access a Form tool is F.
When you press Shift+F the tool selections are cycled through the tools you see in the
toolbar.

As you move the cursor over different tools, the Tool Tips change to reflect the description of
the targeted tool and the keyboard shortcut that can be used to make the tool active. More
Tool Tips are available to you in the form of Extended Tool Tips. An Extended Tool Tip opens
when you keep the cursor over a given tool for approximately three or more seconds. The
first Tool Tip is displayed, then after a few seconds more the Extended Tool Tip appears.
Extended Tool Tips offer you a little more information about what the tool does.

As you become familiar with the tools, you can return to the Preferences dialog box and turn
off the Show tool and property button labels by selecting No labels from the pull-down menu
in the General Preferences dialog box. When No labels is active, your toolbars shrink and
offer you more room in the Toolbar Well.
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Figure 1-35: When you pause the cursor over a tool in a toolbar, a Tool Tip opens with
a description of the tool beneath the cursor. When the preferences have been set to Use single-
key accelerators to access tools, display keyboard shortcuts, the keyboard shortcut is noted
within parentheses.

Palettes
Other tools available to you in all Acrobat viewers are palettes. Palettes are similar to tool-
bars in that they can be docked to a docking station called the Navigation Pane; they can be
undocked and floated around the Acrobat window much like toolbars; they contain pull-down
menus for selecting more options; a series of default palettes appear docked in the Navigation
Pane; and there are additional palettes you can view accessible from menu commands.

Some of the distinctions between toolbars and palettes are that palettes can be placeholders
for information and tools can appear inside a palette. Whereas tools are used in the
Document Pane, many palette operations can take place directly in the palette. Toolbars
remain relatively fixed in size, but palettes can be sized and stretched along the Acrobat win-
dow to provide you with more room to work within the palette or view the information con-
tained within the palette. In addition, some palettes contain their own tools where edits can
be made in the palette and dynamically reflected on the document page. In Acrobat
Professional, palettes help you organize content, view specific content across many pages,
and provide some tools for global editing of PDF files.

Default palettes
Like toolbars, Acrobat Professional displays a series of palettes docked in a well when you
first launch the program. Palettes are contained in the Navigation Pane along the left side of
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the Acrobat window. By default, the Navigation Pane is collapsed; however, PDF documents
can be saved in such a manner where a palette can be expanded when a file is opened in any
Acrobat viewer. These settings are document specific and can be toggled on or off for individ-
ual PDF documents.

For more information about setting various opening views for palette displays, see Chapter 3.

Bookmarks
The topmost default palette tab in the Navigation Pane is the Bookmark tab. PDF documents
can be saved in a manner where the bookmarks are visible when the file opens in Acrobat. A
good example of such a file is the Acrobat Help file. When you open the Acrobat Help file,
bookmarks are visible in an open Navigation Pane as shown in Figure 1-36. You can open and
close the Navigation Pane by pressing F6. You can also grab the vertical bar at the right edge
of the Navigation Pane and move it left and right to size the pane.

Figure 1-36: Bookmarks can be displayed in the Navigation Pane when a file opens.

Bookmarks are navigation buttons that can launch a page, a view, or one of many different
Action types. Anyone familiar with Acrobat already knows much about bookmarks. In
Acrobat Professional, features have been added for viewing bookmark names as well as
expanding, collapsing, and creating bookmarks.

Cross-
Reference
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For learning how to create and manage bookmarks, see Chapter 10. For learning more about
actions associated with bookmarks, see Chapter 15.

Pages
Acrobat users have been familiar with the thumbnail view of each page since the early days
of Acrobat. So, if you are familiar with Acrobat, you will immediately observe the absence of
thumbnails when you see the Navigation Pane for the first time. Don’t despair; you still have
thumbnails in all Acrobat viewers, but they’re not found in a palette called Thumbnails. The
palette name has been changed to Pages. When the Pages tab is opened, the thumbnail views
of each page are displayed in the palette window. The main change with Pages is the ability to
size thumbnails to the same zoom levels as you can in the Document Pane. No longer do you
need to squint your eyes to try to determine what’s on a thumbnail page. In Acrobat
Professional, you can zoom in to the thumbnail views as large or even larger than a page
viewed in the Document Pane, as shown in Figure 1-37.

Figure 1-37: Thumbnails are found in the Pages palette in new Acrobat viewers. The
thumbnail view of document pages can be sized larger or smaller than in previous
Acrobat viewers.

For a complete description for working with pages (thumbnails), see Chapter 10.Cross-
Reference

Cross-
Reference

03 540475 Ch01.qxd  9/4/03  10:01 AM  Page 37



38 Part I ✦ Welcome to Adobe Acrobat Professional

Signatures
The Signatures tab in the Navigation Pane has been repositioned to occupy the third tab spot
from the top of the pane. Users of earlier versions of Acrobat will remember that Comments
followed Thumbnails in Acrobat 5 viewers.

Digital signatures help you manage signed documents by displaying signatures in the
Signature Pane, verifying signatures, clearing them, deleting them, and so on. All these editing
tasks with signatures are still available in Acrobat Professional as well as signature validation,
which is now available in other Acrobat viewers, too.

For a complete description of creating and managing digital signatures, see Chapter 19.

Layers
The new addition to the Navigation Pane in Acrobat is the Layers tab. Users of the many dif-
ferent Adobe imaging applications will appreciate the addition of support for layers in
Acrobat Professional and will already understand terms such as flatten layers, merge layers,
and  so on, which are commands found in the Layers palette.

Flatten Layers and Merge Layers menu commands are only available in Acrobat Professional.

For a complete description for working with layers, see Chapter 17.

Comments
One of the most significant changes to the default Navigation Pane palettes is the Comments
tab. You’ll notice the palette is placed at the bottom of the Navigation Pane. Previously, it dis-
played the comments within a PDF document in a vertical window.  The Comments palette
now shows you comments in a horizontal window. When you open the Comments tab, you’ll
notice a number of pull-down menus signified by down-pointing arrows at the top of the pane,
a list of comments that can be expanded and collapsed, and a host of tools within the palette
as shown in Figure 1-38.

For a complete description for creating and managing comments, see Chapter 14.Cross-
Reference

Cross-
Reference

Note

Cross-
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Figure 1-38: The Comments Pane has been radically changed in Acrobat Professional. Many
more features have been added to the palette as well as tools used for review and markup.

Hidden palettes
Like toolbars, you can choose to view additional palettes through menu commands. A num-
ber of other palettes can be displayed in the Acrobat window and these palettes can also be
docked in the Navigation Pane. To open a hidden palette, choose View ➪ Navigation Tabs.
From the submenu, you’ll find all the palettes available in Acrobat Professional. The list
includes the default tabs. If you select a default tab, the Navigation Pane opens and the
palette is selected. When you select a hidden palette, the palette opens in the Acrobat win-
dow as a floating window with one or more tabs contained in the window.

To dock a tab from a floating window to the Navigation Pane, select the tab to be docked and
drag it away from the floating window. Move the tab on top of an expanded Navigation Pane
or on top of one of the tabs in a collapsed Navigation Pane. When you release the mouse but-
ton the tab is docked in the Navigation Pane. If you dock a tab in the Navigation Pane and quit
Acrobat, the tab will be in the same position when you launch Acrobat in your next session.
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Articles
The first of the hidden palettes listed in the Navigation Tabs submenu is Articles. Choose
View ➪ Navigation Tabs ➪ Articles to open a floating window. When you open the Articles
palette, both the Articles tab and the Destinations tab appear in the window as shown in
Figure 1-39.

Figure 1-39: When you select Articles in the Navigation Tabs submenu, the Articles palette
opens in a window with the Destinations palette.

Articles enable you to create article threads to help users follow passages of text in a logical
reading order. No new features have been added to the Article tool since Acrobat 5.

For information on creating article threads and managing them, see Chapter 10.

Destinations
The Destinations palette is contained in the same window as the Articles palette. With
options in the Destinations palette you can create links to views in documents much like
bookmarks. Destinations have advantages over bookmarks. In Acrobat Professional, the
menu commands are the same as those found in Acrobat 5.

For information on creating destinations and managing them, see Chapter 15.Cross-
Reference
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Content
A new palette designed for managing the structural content of PDF documents is found in the
Content tab. When you choose View ➪ Navigation Tabs ➪ Content, the Content palette opens
in a floating window with the Fields and Tags palettes as shown in Figure 1-40. Content fea-
tures help you reflow tagged PDF files and manipulate the structure of tagged documents.

Figure 1-40: The Content palette opens in a floating window alongside the Fields and
Tags palette tabs. The Content palette is a new feature in Acrobat Professional, enabling
you to manipulate the structural content of PDF documents.

For information on working with the Content palette and tagged PDF documents, see
Chapter 18.

Fields
The Fields palette enables you to manage form fields on Acrobat PDF forms. You can list all
form fields in the palette and execute menu commands from the pull-down menu and context
menu opened from within the palette. Inasmuch as there have been many changes to the way
form fields are created in Acrobat Professional, only a few additions have been made to the
palette options, as explained in Chapter 25.

For information related to Acrobat forms, see Part VI.Cross-
Reference
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Tags
Tagged PDF files provide more editing capability with PDF documents and the files can be
made accessible to adaptive devices such as screen readers. For adding, editing, and annotat-
ing tags in PDF documents, use the Tags palette. Together with the Content palette options,
you now have much more control over document accessibility.

To understand accessibility and the advantages of creating tagged PDF documents, see
Chapter 18.

Info
The Info palette displays the x,y position of the mouse cursor as you move it around the
Document Pane. From this palette you can choose to display from among three different units
of measure — inches, points, and millimeters. No changes have been made to the Info palette
in Acrobat Professional.

For information on working with the Info palette, see Chapter 17.

Palette menus
Each of the palettes contains its own Palette menu. When a palette is open in the Navigation
Pane or in a floating window, select the Options down-pointing arrow to open a pull-down
menu as shown in Figure 1-41. Menu commands found in Palette menus may or may not be
available from the top-level menu bar.

Figure 1-41: Each palette contains a pull-down menu made visible by clicking on the down-
pointing arrow to the right side of Options appearing at the top of the palette.

Cross-
Reference

Cross-
Reference
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Context menus
Context menus can display different options for palette choices depending on where you
open a context menu. If you move the cursor to an empty area when all text and objects in a
palette are deselected and open a context menu, the Menu options may be different than
when you select text or an object in a palette. This is not always the case, because a few
palettes provide you with the same options regardless of whether something is selected or
not. In Figure 1-42 a context menu is opened within the Pages tab. No page is selected in the
palette and you can see the context menu offers you few options.

Compare Figure 1-42 with Figure 1-43. In Figure 1-43 a page was selected in the Pages palette.
When the context menu opens, you can see that many more options are available from the
menu list than when all pages are deselected.

Figure 1-42: When all page thumbnails are deselected and a context menu is opened
from within the Pages palette, only a few menu choices are shown in the open menu.
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Figure 1-43: When a page is selected in the Pages palette and a context menu is opened,
more menu choices are available than when no page is selected.

Accessing Help
You can see that the number of different commands and tools available in Acrobat
Professional are extraordinary and that you haven’t yet looked at all the submenu options or
different preference options accessed from the top-level menu bar. With all these features
available to you, your initial Acrobat Professional sessions can sometimes be overwhelming.
Fortunately, the great engineers and program designers at Adobe Systems thought about you
and they decided to provide some help.

Help with learning more about Acrobat Professional comes in several forms and you can
choose from several help methods to find the one that works well in your workflow. This sec-
tion covers different options for getting help in an Acrobat session.

How To menus
When you launch Acrobat Professional for the first time, you see a window on the right side
of the Acrobat window. It occupies more than a third of the horizontal view and on smaller
monitors, there won’t be much room to work in the Document Pane.
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The window is intended for you to toggle the view on and off as you need help in using
Acrobat Professional on specific limited topics. To hide the menu, click the Hide button
shown in Figure 1-44 or press the F4 key. To open the menu when it’s not in view, choose
Help ➪ How To or press the F4 key again. If you want the window to remain hidden from view
when you launch Acrobat, uncheck the box at the bottom of the window.

You can also open the How To menu from a menu command. Choose View ➪ How to
Window and the window opens the same way as when you press the F4 key.

Figure 1-44: When the How To window is visible it occupies more than a third of the horizontal
width of the Acrobat window. If you do not want the How To window to open when launching
Acrobat, uncheck the box for Show How To Window at Startup.

When the How To window is open, several topics are listed with hot links that take you to def-
initions to the respective items. These items are a condensed version of a more comprehen-
sive help document explained a little later in this chapter. Keep in mind that not all the
Acrobat features are contained in the How To window.

Click on any blue text or the icons adjacent to the blue text to open a view inside the How To
window that provides you with a topical listing to assist in refining your search. If you click
on an item like Review and Comment, you can see a contents list for specific items related to
help on working with comments as shown in Figure 1-45.

Note
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Figure 1-45: Click on a category in the How To window and the window information changes
to reflect information about the topic. In most cases you’ll see a contents list where specific
information about a given category is listed to help you refine your search.

When you arrive at another page that lists the contents, as shown in Figure 1-45, click again
on any text displayed in blue to link to information about the subtopic. Using the example of
Review and Comments as a category, you could choose to click on Start an e-mail review. The
window opens the page where you see a description for how to e-mail comments in a PDF file
as shown in Figure 1-46.
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Figure 1-46: Click on an item in the contents page and you are linked to a page where a
description appears that explains how to perform a task.

In some cases, you’ll see a text description informing you how to go about archiving a result
for the item you searched. In other cases you can find dynamic links that help you execute a
task. For example, with regard to sending an e-mail with comments attached, there is a button
in the How To window stating Do it for me. Click on this button and Acrobat invokes the com-
mand that permits you to e-mail a PDF attachment. With this particular task you are
prompted in a dialog box to specify an e-mail address for the recipient of your data. The How
To help item invokes the command for you and opens the dialog box where the e-mail
address is typed as shown in Figure 1-47. Replace the default text with a legitimate e-mail
address, click OK and the document is packaged and your e-mail program is launched with
the PDF document attached to it.
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Figure 1-47: How To menus contain task buttons that perform aspects of a task you are
learning. As an extension of providing you with help information, Acrobat walks you through
steps in some tasks.

Some How To descriptions are text only and won’t necessarily contain buttons to launch an
action. In other cases you’ll find this method of help to be of great assistance in executing
some operation you’re not familiar with. Task buttons in the How To window are actually exe-
cuting some of the same commands you can find from using tools, menu items, pull-down
menus, and palette tools.

Docking the window
The window is docked on the right side of the Acrobat window by default. You can move the
window to the left side by opening a context menu on the title bar above the How To pages.
When you open a context menu from the title bar, select the item Docked Left. The window
moves to the left side of the Acrobat window and the Navigation Pane and Document Pane
slide to the right.

The size of the How To window is fixed and you can’t change the horizontal width. Be certain
to remember the F4 shortcut to show/hide the window because there won’t be much room to
work in the Document Pane when the window is in view.
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Navigating the How To window
You can return to the opening view of the How To window, called the Homepage, by clicking
on the icon in the top-left corner of the window. The left and right arrows move to the previ-
ous and next window views, respectively. Clicking the arrow does not scroll pages. Rather, it
helps you retrace your steps to go back and forth to the recent views. However, if you navi-
gate through a series of pages and click on the Homepage button, it resets the viewing history
and you won’t be able to use the arrow buttons to retrace your last views. A vertical scrollbar
is displayed on the right side of the How To window when the description is longer than can
be viewed on your monitor. If the description is short, you won’t see a scrollbar.

At the bottom of some descriptions you can find more related information on the topic you
searched. Again with hot links, click on text or an icon to open another page offering you
related information. If you want to return to the contents, click on another button, also visible
at the bottom of a description page, indicating you will return to the topics.

If you want to open another topic without being on the Homepage, you can open the How To
Tools menu in the Acrobat Toolbar Well. The down-pointing arrow opens a pull-down menu
with the same topics as are listed on the How To Homepage.

Acrobat help
The How To window contains a select group of common Acrobat features where you can find
help within the listed topics on the Homepage. You can also access more topics by clicking
on the More Topics button on the Homepage. After you click More Topics, another list is dis-
played with more links to How To descriptions. However, Acrobat is a monster program with
many features and listing all the methods for working in the program is not the intent for the
How To help. To browse through a comprehensive help guide you need to access a different
document. The comprehensive help guide contains more than 650 pages covering just about
everything you want to know about Acrobat Professional. There are, in essence, two flavors
of the Acrobat Help guide. You can access the Complete Acrobat 6.0 Help document from the
Homepage in the How To window or you can open the Acrohelp.pdf file in Acrobat. These two
documents are different in that one is part of the program’s interface and the other is a PDF
document. Depending on which one you open, you have some different methods for viewing
and navigation.

Complete Acrobat 6.0 Help
The Complete Acrobat 6.0 Help is opened from the Homepage in the How To window. When
you open this document without a PDF file open in the Document Pane you’ll immediately
notice you have no access to tools and menu commands. That’s because the document
you’re looking at is not a PDF document. It appears similar to files you open in Acrobat with a
Navigation Pane on the left side of the window and the page contents to the right. It can be
sized and scrolled, but the file is not confined to the Document Pane like PDF files. It behaves
more like a floating window on top of the Acrobat window.

To open the Complete Acrobat 6.0 Help file click on the Complete Acrobat 6.0 Help button on
the Homepage in the How To menu. When the file opens you see a contents list on the left
side and the page contents on the right side of the floating window as shown in Figure 1-48.
You can size the Navigation Pane on the left side of the Help window to show more or less of
the contents list by dragging the vertical bar left to size down and right to size up.
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Figure 1-48: The Complete Acrobat 6.0 Help opens as a floating window. When no other
file is open, all tools and menus are disabled.

The Complete Acrobat 6.0 Help document contains three tabs in the Navigation Pane and a
Topic Pane where pages contain help information. The tabs enable you to list topics, search
on keywords, and display an alphabetical index.

Contents tab
By default the Complete Acrobat 6.0 Help document opens with the Contents tab exposed as
shown in Figure 1-48. In the Navigation Pane you’ll find a table of contents for the document
shown in a very similar manner to the way bookmarks are listed in a PDF document. To
expand the parent item, click on the plus sign. Subtopics are listed when a parent topic is
expanded. To collapse a parent item, click the minus sign adjacent to the parent item you
expanded. Click on one of the parent or child topics listed in the Contents tab. The respective
page appears in the Topic Pane.

Search tab
To find any word(s) in the help document you can search on words you type in the Search
tab. Click the Search tab and the Navigation Pane changes to display a field box where you
type your search criteria. Type one or more words in the field box and click Search. The
results are then displayed in the Search tab. All text appearing in blue is linked to the page
that opens in the Topic Pane as shown in Figure 1-49.
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Figure 1-49: The Search tab enables you to search for words contained anywhere in the
help document. The search results contain links to pages where the found words appear.

When performing a search in the Search tab you are limited to searching by words only in the
search field. You cannot use operators or Boolean expressions. The Search tab works very
similarly to the Find command in Acrobat. When you search multiple words, the search
results are reported for all instances of all words.

For more information on using expressions and Boolean operators when searching PDFs,
see Chapter 4.

Index tab
The Index tab is similar to any index you find in a manual or book. When you click on the tab,
a list of alpha characters (A to Z) appears in the Navigation Pane. The alpha characters are
parent markers that can be expanded like the Contents items. Click on the plus sign and the
category expands. Click on a child item in the expanded list and the page link opens in the
Topic Pane as shown in Figure 1-50.

At the top of the Index tab is a pull-down menu where you can select any alpha character or
select All to show the entire alpha list.

Cross-
Reference
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Figure 1-50: The Index tab displays an alpha list for index items. Click on the plus sign to
expand an alpha list and click on a listed topic to display the corresponding page.

Navigating topics
The arrows at the top of the Navigation Pane enable you to move forward and back to the
pages you view during your search. The review history remains in memory until you close
the document. If you close the help file, the review history is flushed from memory and you
need to begin again to find information on the same topics.

Printing topics
The Print tool located at the top of the Navigation Pane prints pages from the help document.
Navigate to the page you want to print and click on the tool and print the respective page or
select a range of pages to print in the Print dialog box. 

Acrohelp.pdf
When you open the Complete Acrobat 6.0 Help from the How To window you access a docu-
ment that can only be managed by the tools within the floating window. If you want to copy
text, print multiple pages or the complete help document, make notes with Comment tools,
or perform a sophisticated search with Boolean operators, the Complete Acrobat 6.0 Help file
prohibits you from performing any of these tasks. Fortunately an identical file in terms of
content is available in the Acrobat Help folder added as a PDF file when you install Acrobat.
You can open this file and perform any tasks you normally do in Acrobat on any other PDF
document.
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When you open the Acrohelp.pdf file from the Help ➪ ENU folder inside your Acrobat folder,
the file opens like any other PDF as shown in Figure 1-51. The PDF document opens with
bookmarks visible in the Bookmark tab in the Navigation Pane and these bookmarks contain
similar descriptions as the contents do in the Complete Acrobat 6.0 Help file. You also have
an index to help you search for topics from an alphabetical list.

Figure 1-51: The Acrohelp.pdf document contains bookmarks and an index. You can use 
any of the Acrobat tools to view and print the document.

In addition to the use of tools and viewing the file like any other PDF document, you can
search for information within the PDF file by entering your search criteria in the How To win-
dow. Type the word(s) to be searched and click on the Search button. The search results are
reported in the How To window as shown in Figure 1-52. Click on any text shown in blue and
the page containing your first search results opens in the Document Pane. 

Advanced search is available to you using Acrobat Search. An index for the file has been cre-
ated for you and is also installed with your Acrobat installation. You need to load the index
before using more advanced search tools and then you can refine your search with many
more search features.

There’s a lot to know about Acrobat Search and you’ll find it all covered in Chapter 4.Cross-
Reference
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Figure 1-52: The How To window contains a field where search criteria are supplied.
When you click on the Search button in the How To window, the search results are listed
in a scrollable window below the Search button.

More help
In addition to the help file that covers working in Acrobat Professional, some other help PDF
files are located in the Help folder inside your Acrobat folder. These help documents are spe-
cific to certain tasks like pdfmark and JavaScript. To view the help documents, open your
Acrobat folder and open the Help:ENU folder. The files are PDF documents and can be opened
in any viewer. 

You will find some dialog boxes offering you help as you work in Acrobat. The discussion for
acquiring help from dialog boxes will be addressed in subsequent chapters where help
appears in dialog boxes opened while performing different tasks.

Online help is available to you as well from Adobe Systems. If you select the Help menu and
choose the menu command Acrobat Online, your default Web browser launches and the
Adobe Acrobat products page opens from Adobe’s Web site. This Web page and links to the
page are continually updated so be certain to make frequent visits to the Acrobat Online help
Web pages.

When accessing Adobe’s Online Help, your Web browser opens in the foreground while
Acrobat Professional remains open in the background. When you finish viewing Web pages
and quit your Web browser, the Acrobat window returns to view.

Note
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Understanding Preferences
Preferences enable you to customize your work sessions in Acrobat. You can access a
Preferences dialog box from within any Acrobat viewer and from within a Web browser when
viewing PDFs as inline views. A huge number of preferences exist that all relate to specific
tool groups or task categories, and it would not make as much sense to cover them here in
the opening chapter as it would among all the chapters that relate to the preference choices.
You had a glimpse of the Preference dialog box earlier in this chapter. The remaining prefer-
ences are covered in many of the chapters ahead.

Some general things you should know about preferences is that they are contained in a dialog
box as shown in Figure 1-34. You make a topic selection in the list on the left side of the dialog
box and the related preferences are shown to the right side of the list. You make choices for
preferences by checking check boxes or making menu selections from pull-down menus.
When you complete making your preference choices, click the OK button at the bottom of the
dialog box.

Almost all the preferences you change in the Preferences dialog box are dynamic, which
means you don’t need to quit Acrobat and relaunch the program for a preference choice to
take effect. Preferences remain in effect until you change them again. If you quit Acrobat and
relaunch the program, the preferences you set are honored by Acrobat. However, if for some
reason the program crashes and you don’t shut it down properly, any new preference
changes will not be recognized when the program is launched again.

If you find some operation in Acrobat not working as you think it should, first take a look at
the Preferences dialog box. In many cases you’ll find a check box or menu command not
enabled to permit you to perform a task. As you become familiar with specific tool groups
and menu commands, make a habit of routinely visiting the Preferences dialog box so you
understand all the toggles and switches that affect tool and viewing behavior.

Summary
This chapter offers you a general introduction for working in Acrobat, both Acrobat Standard
and Acrobat Professional, and helps you understand the environment, the user interface, and
some of the many new features added to the commercial Acrobat products. At the very least,
you should know how to go about finding help when you first start working in the program.
Some of the more important points discussed in this chapter include the following:

✦ Adobe Acrobat is a multi-faceted program designed to provide solutions for many dif-
ferent business professionals. Several types of Acrobat viewers exist, ranging in fea-
tures to suit different user needs. The most sophisticated of the three viewers is
Acrobat Professional now in version 6. Acrobat Standard offers fewer tools and menu
commands than Acrobat Professional.

✦ PDF, short for Portable Document Format, was developed by Adobe Systems and was
designed to exchange documents between computers and across computer platforms
while maintaining file integrity.

✦ The PDF language format has changed version numbers along with the Acrobat view-
ers. The current PDF version is 1.5.

03 540475 Ch01.qxd  9/4/03  10:01 AM  Page 55



56 Part I ✦ Welcome to Adobe Acrobat Professional

✦ Acrobat Professional has introduced many new features and boasts a major upgrade
and many new changes to the user interface.

✦ Tasks are performed through the use of menus, tools, and palettes that can be
accessed through mouse selections and keyboard shortcuts.

✦ The extensive list of tools appears in an abbreviated form when you open Acrobat and
view the default toolbars. You can open additional toolbars from menu commands. You
can dock toolbars in the Toolbar Well or float them around the Acrobat window.

✦ Palettes are similar to toolbars in that they can be docked and undocked from a well
called the Navigation Pane. Palettes contain pull-down menus, and some palettes con-
tain tools.

✦ The Acrobat workplace can be customized to suit your work style through the use of
different preference choices. When preferences, palettes, and toolbars are changed
from their default views, the new views are saved when you quit your Acrobat session.
They remain unchanged until you change them again or reset them to defaults.

✦ Acrobat Professional provides you extensive assistance through the use of help docu-
ments. You can gain immediate help on selected topics through choices in the How To
window or by expanding your list of categories to seek help in the Complete Acrobat
6.0 Help window.

✦ A companion file identical to the Complete Acrobat 6.0 Help document is available in
PDF form. The PDF file can be searched with Acrobat Search and printed in entirety.

✦ ✦ ✦
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